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PREDGOVOR

Pred vama je novi priruénik za ARCHICAD 19. Nazvali smo ga ,,Tri knjige u jednoj*,
jer se sastoji iz tri originalna Graphisoftova e-priru¢nika:

m  ARCHICAD BIM concept
m  Conceptual Design i
m Intermediate ARCHICAD

Ovaj priruc¢nik ¢ini zaokruzenu celinu za pocetnike i omogucava profesionalcima da
upoznaju unapredenja u odnosu na ranije verzije ili da ,,0osveze* osnovna ARCHICAD
znanja i namenjen je za nove korisnike ARCHICAD-a, kao i za studente i profesore koji
ga koriste kao deo BIM Curriculum seta predavanja.

Kako da koristite prirucnik?
1. Instalirajte ARCHICAD 19.
2. Pratite uputstva iz knjige.
3. Po zelji pratite video klipove sa YouTube ARCHICAD kanala.

Instalirajte ARCHICAD 19 na racunaru da stvorite uslove za neometano koris¢enje
ovog prirucnika. E-knjiga je kreirana koris¢enjem INT (English) i US (Imperial) verzije
ARCHICAD-a, pa, stoga, preporu¢ujemo da upotrebite istu verziju za vezbu.

Kako da nabavite ARCHICAD?

Preko stranice graphisoft.com/downloads odnosno myarchicad.com, vrsi se registracija i
preuzimanje ARCHICAD-a za BESPLATNO korisc¢enje:

m  Ako ste student, profesor ili ste zaduzeni za softver neke obrazovne
institucije, koristite obrazovnu/edukativnu licencu. Ona je puna funkcionalna
verzija ARCHICAD-a.

m  Ako ste profesionalni arhitekta, preuzmite TRIAL, punu funkcionalnu
verziju ARCHICAD-a. Projekti snimljeni u ovoj verziji automatski se
nadograduju na pune verzije nabavkom komercijalne licence.
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Kako dalje?
Za one koji su savladali osnovnu obuku Graphisoft je spremio jos dve e-knjige:

Advanced ARCHICAD 1 Using Teamwork, koje mozete preuzeti na graphisoft.com/learning/
training-materials/.

Odgovore na vasa pitanja mozete naci u bazi ARCHICAD znanja, koja se redovno dopunjuje na
helpcenter.graphisoft.com.

Vas lokalni distributer je hiCAD, ovlasc¢en i osposobljen za obuku, tehni¢ku pomo¢ i uvodenje
ARCHICAD-a. Njegova internet prezentacija je na hicad.rs - posetite je i besplatno preuzmite
template.

Za nabavku komercijalne ARCHICAD licence javite se na e-meil adresu hicad@sbb.rs..

Nadamo se da ¢e vam ovaj priru¢nik biti koristan i zelimo vam uspeh u budu¢im ARCHICAD
projektima!

Srecno!

GRAPHISOFT tim



ARCHICAD BIM koncept

Uvod

Dobrodosli u Seriju ARCHICAD vodica!
Ovaj vodi¢ je deo Serije ARCHICAD prirucnika koji trenutno sadrzi slede¢e materijale:
m  Vol.l1 - ARCHICAD BIM koncept
m  Vol.2 — Konceptualno projektovanje u ARCHICAD-u
m  Vol.3 — Osnovni ARCHICAD
m  Vol.4 — Napredni ARCHICAD
m  Vol.5 — Primena timskog rada - Teamwork

Vi sada ¢itate Vol.1 - ARCHICAD BIM koncept je sveobuhvatan prakti¢ni vodi¢ za
upoznavanje koncepata modelovanja i dokumentacije u ARCHICAD-u.

Da biste uspesno koristili ovaj materijal, pazljivo pro¢itajte Predgovor.
Sre¢no!

GRAPHISOFT tim
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Interfejs ARCHICAD-a

Da biste zapoceli istrazivanje ARCHICAD-a, prvo otvorite fajl primera. Pokrenite ARCHICAD,
tako Sto ¢ete kliknuti na ikonicu aplikacije. Prvo ¢ete se susresti sa prozorom za unos podataka, u
kojem birate izmedu kreiranja novog projekta ili otvaranja postojeceg.

Uradi¢emo ovo drugo, pa, stoga, kliknite na radio-dugme Open a Project.

U drugom odeljku prozora izaberite opciju Browse for a Solo Project. Izaberite opciju Stan-
dard Profile 19 za radno okruzenje Work Environment i kliknite na Browse.

o Start ArchiCAD 19

What would you like to do?

D Create a New Project
‘::g © Open a Project

You can:
© Browse for a Solo Project
Browse for a Teamwork Project

Select a recent Project

Set up Work Environment

@ Use: {ij' Standard Profile 19 B

Quit ArchiCAD Browse...

Do not Display this Dialog Next Time

U prozoru za pretragu, u direktorijumu sa projektima za trening, potrazite i otvorite fajl projekta
NHS Office 19 metric.pla.
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Ako imate edukativnu verziju ARCHICAD 19, bi¢e prikazan dijalog prozor, koji vas obavestava
da treba da konvertujete projekat u Education format.

ArchiCAD is running in educational mode.

If you save a commercial file in this mode, it will be
converted to an Education version file.
This action is not undoable, and henceforth you will

not be able to use the file for commercial purposes.

[ Cancel | [ Convertto Education |

Kliknite na dugme Convert to Education. Posto otvarate takozvani arhivirani projekat, koji
sadrzi sve eksterne elemente upotrebljene za kreiranje ovog projekta, bice vam postavljno pitanje
kako zelite da rukujete ovim elementima. Za sada to zanemarite i zadrzite sve elemente projekta
u arhivskom fajlu, pa, stoga, bez ikakve promene u radio-dugmadima, jednostavno kliknite na
Open.

Active Library Usage

(®) Read elements directly from archive
() Extract elements to a folder

(O Select a library

Information:

Choosing this option will not extract the library elements, saving
you disk space. Use it if you do not plan to work on the library
parts and intend to preserve the archive format.
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Otvorice se fajl projekta. Pogledajte detaljnije interfejs ARCHICAD-a. Ovu aplikaciju su dizaj-
nirali arhitekte za arhitekte. Razumljiv graficki interfejs i1 vizuelne povratne informacije ¢e vam
pomoci da brzo upoznate mogucnosti programa.

. Te T View SIgn. ument  Options  Teamwort findow _ Test b =S AR P I =] N Q =
000 p.p
D@ |8 & b @ o (&2 F = ‘;Dv‘vmmxxwxr: SEERIEDS
Sooct
S5 | IEEEEEROTEN
£33 Marqu. o oo T ]
B 51 oo 2 foror perspecive o1 R ][ B =To]a
& Wal | T v f NHS OFFICE COMPLS
PP P e . . . v EStories
JS‘?,‘.’Z;*— Paleta sa Glavnalinija  Osnovna linija Paleta sa Linija kartica Navigator . oot
s .. : . . A . P e s reor
§ column alatima menija sa alatima informacijama saprikazima paleta projekta i
e : [B50. 1 floor
ey ‘ L o [ i e
° ' Graficki radni ekran - |  [@sections
& stair 1 ) ] | £301 A_A Section
| @ Roof | | i} | 1202 8_8 Section (
\oe Shell | £2036.6 Soction
27510t ; = 3 ; o
4 Curtai... . e N S S i | 10 Curtain Wall
& Morph i S 3 4 | £111 Curtain Wall §
i T D — | ] P £212 Curtain Wail §
B object | } =1
{ | 13 Curtain wai
|1 zene [og S | iE | | : ,O 214 Curain Wail §
& Mesh = : : | £215 Lobby SikyligH
v Document| £316 Lobby SkyligH
+ Dime... 317 Lobby Stair (4
ot Le:: " 118 Shade (Orawi
 @ovations
A Text e 2205 South Elovatd
A1 Label 106 East Elevatior
&, Fill 207 North Elevati
/ Line 008 West Elevatio
O Arc/C. |
(Z Polyli... | v [@0etails
| orawi.. et | 01 Vertical Unit
. Sectior o = | =[x
& |
.~ Eleva... > i o) J v Propertios
4 Interi... o> ¢> (D b 0.1 floor
Itk Settings..
LMoo FI@IEF] 100 | 25% [ [QHQTQATHAIS] 000" Q.
Click an Element or Draw a Selection Area. Press and Hold Ctrl+Shift to Toggle Element/Sub-Element Selection. =

Centralni deo interfejsa prikazuje nacrt projekta. Povrh njega nalazi se linija kartica koja prika-
zuje ostale otvorene prikaze. Na dnu ekrana se nalazi set ikonica koje pomazu da pretrazujete
ovaj prikaz, da se kreéete u njemu i da postavite razmeru crteza i faktor uveli¢anja.

F@iIe2l 1100 [ 26% [» [QE@IQISTQIST o000° [«

Levo se nalazi Toolbox - paleta sa alatima koja sadrzi sve alate koji su potrebni za kreiranje 3D
modela i projektne dokumentacije.

Desno se nalazi Navigator koji lista sve aspekte projekta — ovde mozete da se prebacujete sa
jednog sprata na drugi ili na razli¢ite 3D prikaze, preseke, izglede i detalje.
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Na vrhu ekrana se nalazi Menubar, linija menija u kojoj su navedene sve dostupne komande
u programu, logicki grupisane. Komande za operacije sa fajlom (File) i funkcije za editovanje
(Edit) i prikazivanje (View) mogu da se selektuju iz odgovarajucih padajucih menija.

ArchiCAD File Edit View
About ArchiCAD®... D) New > © Navigate >
@2 Work Environment... (= Open > 3 5
Project Preferences > B Close Project ~%W O On-Screen View Options >
Services » & ¥ (@ Trace or2
e Vv i\ Guide Lines L
Hide ArchiCAD _%H =) :a‘/e 0:: & oy i Snap Guides
Hide Others N#H WSaveas... @ Paste V' /< Snap Points
i###f Grid Display
3 » (c] s v Q Editing Plane Display
SEAICNCAD 29 @ Publish BIMx Hyper-model... il Sglect &l Eda 3 o g ==
File Special > & Find & Select... 8F =z Grid Snap s
&3 Search & Replace Text... = Ruler
External Content »  Check Duplicates > .
Libraries and Objects > T'a.c 9 Optxons . i
Info » Grouping 'S Guide Llng Options >
Display Order »  Snap Options >
3 Plot Setup... Locking > Grid & Editing Plane Options >
& Plot... Grid Snap Options >
Move >
&y Page Setup... %P Align » Zoom >
& Print... %8P E'SK;:bme L Elements in 3D View >
SR > 3D View Options >
Element Settings > >
®
Reference Line and Plane > ’R
3D Navigation Extras >
Refresh >

Posto su modelovanje i izrada dokumentacije Design i Documentation zasebni procesi u arhitek-
tonskoj praksi, alati i komande koji podrzavaju ove procese se takode nalaze u posebnim meni-
jima. Komande u meniju Options reguliSu osnovna podesavanja i radno okruzenje.

Design Document Options
Design Tools > Documenting Tools > Element Attributes >
#X Outline Polygon with Magic Wand 4 Mark-Up Tools "
: (B Change Manager v & Element Snap QE
Story Settings... ®7 Spell Checker » v I Surface Snap
= Document Extras > /|- Auto Intersection
Complex Profiles »  Set Model View > ‘7 Magic Wand Settings...
Update Zones... Layers > 3 Intersections in Layer Combinations
Align 3D Texture »  Renovation » £ Import RAL Colors...
Pen Sets > Find & Replace in Library >
| 2
E :o;':\:t o - Partial Structure Display... Import Standard Steel Profile...
olid Element Operations... 2 Floor Plan Cut Plane... Show labels for neigs
& : T Floor Plan Scale... £ Add-On Manager...
LEGIAEED b 3D Document >
Modify Curtain Wall > Creative Imaging > Project Preferences 4
i >
Schedules and Lists > Work Enviconiment
Place Mesh from Surveyors Data... Project Indexes >
2 Grid System ...
Layout Book >
Roof Extras > ®5Save View and Place on Layout 7
Design Extras > Drawings >
@ Energy Evaluation > & Publish

Meni Teamwork podrzava timski rad na projektu, a meni Windows nudi opcije za podesavanje
vidljivosti linija sa alatima i paleta.
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Teamwork Window
Project > [*0 Close Tab Project #’W
Undock Tab 0. 1 floor
Close All Other Tabs and Windows

Hide Tab Bar

Show Next Tab ol

Show Previous Tab A

) Enter Full Screen ~38F

] Hide Palettes and Toolbars

Toolbars >

Palettes >
e

v [&] Floor Plan F2

[& Teamwork Palette [&] 3D Window

Help
Search Q

(@) ArchiCAD Help

X Hide Help Tags
LicenseManagerHelp

GDL Reference Guide
Create Support Package...

{5 ArchiCAD YouTube Channel

& Check for Updates...
Customer Experience...
License Information...
About ArchiCAD®...

Standard Toolbar osnovna linija sa alatima sadrzi komande i funkcije koje su dostupne u meni-
jima. Nalazi se odmah ispod linije menija i moze se u potpunosti prilagodavati (ceo korisnicki
interfejs moze da se uredi u takozvane Seme za brzo pracenje ponavljajuéih radnji ili po zelji

korisnika, ali ta tema u ovom vodi¢u nije obradena).

Prozor za informacije (Info Box) prikazuje podesavanja izabrane alatke ili karakteristike selekto-
vanog elementa. Isprobajte ovo polje, tako §to cete selektovati razlicite alate iz palete sa alatima.
Pogledajte promene u polju za informacije. One su odmah reflektovane u aktuelnim podesava-
njima ili karakteristikama selektovanog elementa. Prozoru za informacije mozete da promenite
veli¢inu (sli¢no svim prozorima i paletama) da biste sagledali viSe informacija, osim osnovnih

podesavanja.

Navigacija u ARCHICAD-u

Navigacija crteza

Pogledajte detaljnije prikaz osnove. Medu ikonicama na dnu prikaza izaberite ikonicu Increase

Zoom.

FEI@RIE] 196 | 20% [» [QE@IQIS[@IS] o000 [«qC»

Kursor se menja u lupu. Kliknite na dva ugla pravougaonika oko podrucja gornjeg desnog ulaza

u zgradu.
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Navigacija u ARCHICAD-u
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Isprobajte i druge ikonice (Panning, Reducing Zoom, Fitting in Window) za navigaciju kroz pri-
kaz ili se prebacite izmedu prethodnog (Previous) i sledeceg (Next) prikaza.

Postoji 1 brzi nacin za navigaciju u svim prikazima. Pomocu kursora u glavnom prozoru pritisnite
dugme za skrolovanje na miSu da biste se pomerali po aktivnom prikazu modela. Ne zaboravite
da drzite pritisnuto dugme za skrolovanje.

Povlacenjem dugmeta za skrolovanje nagore aktivni prikaz e biti uveli¢an, a povlacenjem
nadole ¢e biti smanjen. U ovim slu¢ajevima pozicija kursora ¢e se ponasati kao centralna tacka
projekcije.

Ova tehnika omoguc¢ava da se veoma brzo pomerate sa jedne lokacije prikaza na drugu.

Navigacija 3D modela

U ARCHICAD-u svaki element zgrade je odmah predstavljen i u 3D-u. Naravno, ovaj primer
projekta ukljucuje ne samo 2D dokumentaciju, ve¢ ceo 3D model zgrade. Mozete da upotrebite
padajuci meni linije sa karticama ili elemente u Navigatoru da biste se kretali izmedu projekto-
vanog i 3D prikaza ARCHICAD modela. U ovom primeru upotrebicete prikaze Navigatora u
Project Mapu. Dakle, kako model izgleda u 3D-u?

3D model moze da bude prikazan u aksonometrijskom prikazu ili prikazu perspektive. Prvo éete
isprobati aksonometrijski prikaz. U Project Mapu Navigatora, u odeljku 3D prikaza, dvostrukim
klikom aktivirajte Generic Axonometry.

2> & B=E|S
v {4 NHS OFFICE COMPLE!
v [&] Stories
[Bx3. roof
Bg2. 3 floor
B 1. 2 floor
[230. 1 floor
[Bx-1. foundation
» [@]Sections
» [@]Elevations
[&] Interior Elevations
[Z]Worksheets
» (@] Details
» [$3]3D Documents
v [&]3D
&1 Generic Perspecti
» 55 00 Untitled Path
» [E8) Schedules
» [=]Project Indexes
» [@]Lists
» [E@]Info
» [G]Help
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Kao rezultat, videcete nesto slicno ovome:

Unutar 3D prikaza alatke za navigaciju (zumiranje i pomeranje) funkcioniSu potpuno isto kao i
na prikazu osnove. Upotrebite dugme za skrolovanje na misu da biste se pomerali sa jednog dela
modela na drugi.

Zadrzite prikaz u kojem zgrada manje-vise ispunjava glavni prozor. Postoje dva razli¢ita na¢ina
za navigaciju u modelu: Orbit i Walk. Pogledajte kako funkcionisu ove opcije. 1z palete sa alat-
kama na dnu ekrana izaberite ikonicu Orbit.

ERRIIE als el 2 [QeQlcs

Kursor ¢e se pretvoriti u znake male orbite. Kliknite i drzite pritisnut levi taster miSa i pomerajte
mi$ da biste pregledali zgradu sa svih strana.

Dok je ukljucen rezim Orbit, mozete istovremeno da koristite funkcije za uvelicanje i pomeranje.
Isprobajte ove funkcije da biste istrazili ceo model. Za izlazak iz rezima Orbit pritisnite taster
ESC.

Postoji jos interesantniji nacin pregleda zgrade. Da biste to videli, dvostruko kliknite na Generic
Perspective u 3D odeljku Navigatora. Rezultat je slican slede¢em:
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U ovom prikazu funkcije za obrtanje, zumiranje i pomeranje se primenjuju kao §to ste vec i
videli. Jedina razlika je $to one utiu na poziciju kamere, a ne na projektovanu sliku.

Za drugaciji nacin istrazivanja ukljucite rezim first-person shooter, tako $to Cete izabrati ikonicu
Explore u donjoj liniji sa alatima.
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Prozor koji ¢e biti prikazan obja$njava kontrole koje su veoma sli¢ne FPS ra¢unarskim igrama.

3D Explore information

\ Use the following techniques to navigate.
\ ( Rotate camera by moving the mouse.
N\
Walk forward: Arrow Up / W
. & Walk backward: Arrow Down / S
—/\ Lateral move left: Left Arrow / A
Lateral move right: Right Arrow / D
~
l Co up: PgUp / Space
Co down: PgDown / C
Fly mode: F
A\
Hurry: Shift
Increase Speed: + /.
Decrease Speed: -1/,
Quit Explore mode: Mouse Click / ESC
Help: Cmd+?
[_| Do not show this information next time
| Cancel | 3D Explore

Nakon $to upoznate kontrole, kliknite na 3D Explore da biste zapoceli navigaciju kroz unutras-
njost zgrade 1 simulaciju kretanja po njoj.

Zidovi vas nece zaustaviti u ovoj ,,igri“, ali, da biste dobro upoznali zgradu, pokusajte da koristite

vrata.

Da biste napustili rezim Explore, kliknite bilo gde na 3D prikaz.

Koncept virtuelne gradnje

Kako je moguce da ste videli samo jedan prikaz osnove, a odmah mozete da istrazite i celu
zgradu? Pogledajte sada kratak uvod GRAPHISOFT-ovog koncepta virtuelne gradnje (prvi put
je predstavljen 1984. godine), odnosno BIM-a (Building Information Modeling), kako se naziva
u poslednje vreme.

Dvostruko kliknite na 0.1 floor u odeljku Stories u Navigatoru. Odmah ¢ete biti vraceni na
pocetni prikaz. Mozete da podesite kompletan prikaz sadrZaja osnove u prostoru radnog ekrana -
ako je to potrebno, tako Sto cete kliknuti na Fit in Window.
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Jedan od osnovnih koncepata BIM-a je da je 3D model napravljen od realnih gradevinskih kom-
ponenata, kao $to su zidovi, grede ili ploce. Pogledajte detaljnije ARCHICAD zidove kao primer.

Dvostruko kliknite na alatku Wall u paleti sa alatima. Otvoriée se prozor za unos podataka Wall
Settings.

Wall Default Settings

Favorites... METRIC version Default

_— o
gi Geometry and Positioning

Wall Top:
Not Linked B alm
I]D]]S(ucco 2side +v.b.+2x4 »
1100| mlz [
AN =
Home Story:

0. 1 floor (By Elevation) <

to Project Zero|»|  Reference Line:

= [0 2|5 S o

¥ Py Floor Plan and Section

- FLOOR PLAN DISPLAY
Show on Stories Home Story Only = 5
Floor Plan Display Projected with... F=7]
Show Projection Entire Element bg

- CUT SURFACES

¥ oOverride Cut Fill Pens None

v OUTLINES

> &, Model

» @ Tags and Cateqories

£% & Walls_Exterior » Cancel [—Cr—

U panelu Geometry and Positioning moZzete da odredite geometriju zida, ukljucujuéi informa-
cije o visini, obliku i vertikalnoj poziciji zida.

U panelu Floor Plan and Section mozete da podesite kako ¢e zid biti predstavljen u 2D prika-
zima, kao $to su osnova ili presek. Mozete da podesite karakteristike zida (ili njegov simbol za

prikaz) za upravljanje njegovim prikazom. Ovde mozete da izaberete strukturu viSeslojnog zida
ili druge karakteristike u vezi sa 2D prikazom.

U panelu Model mozete da odredite kako zid treba da izgleda u 3D prikazima. Ovde mozete da
odaberete povrsinske materijale i teksture.

Na panelu Tags and Categories omoguceno je da dodelite svojstva izabranim elementima. Ove
svojstva su veoma vazna kada saradujete sa razli¢itim disciplinama i razli¢itim programima.

Poenta ovakvog koncepta je da element koji ste nacrtali na osnovi ili postavili u 3D prozoru u
prikazu perspektive nije samo 2D simbol ili skup paralelnih linija ili samo 3D oblik. Element je
sve to i viSe od toga: to je gradivni element virtuelne zgrade koji je osetljiv na okruzenje i ,,zna“
kako da se predstavi unutar razlicitih aspekata arhitektonske dokumentacije.

Kliknite na Cancel ili ESC da biste zatvorili prozor.
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Sta to znaci u praksi? IzvrSite sada neke promene i videcete Sta ¢e da se desi.

Da biste odmah videli promene u drugim prikazima, upotrebite ARCHICAD-ovu jedinstvenu
alatku Trace and Reference. Da biste otvorite 05 South Elevation prikaz, pronadite ga u Navi-
gatoru, kliknite desnim tasterom misa i iz padajuc¢eg menija izaberite opciju Show as Trace

Reference.

i

;] | ]

Open
Open in New Tab
New Independent Elevation...

Rename Elevation...
X Delete Elevation

| IShow as Trace Referencel

v [&]Elevations

Referentni prikazi imaju mnogobrojne opcije za korisnike za pozicioniranje, rotiranje ili prikaz.
Otvorite paletu Trace and Reference za brz pristup. Kliknite na crnu strelicu pored ikonice zutog
i plavog kvadrati¢a na osnovnoj liniji menija (Standard Toolbar) i iz padaju¢eg menija izabe-
rite Trace & Reference. Postavite prikazanu paletu u gornji levi ugao radnog ekrana. Upotrebite
komandu Drag Reference da biste prevukli prikaz izgleda ispod prikaza osnove.

@ Trace & Reference
(8| | £ 05 South Ele... »

s [@
Dragb eference
mererence:

»

Active:

@

o | = | &

o [@[]

Omogucite da referenca ima svoju originalnu boju klikom na ikonicu Reference color i odabe-

rite Original Color.

[®@  Trace & Reference

AERED

Reference:

(3 |22 05 South Ele... » [

’“ @ Original Color | |
Active: Vv Uniform Color (R:195 G:195 B:145)
@»| Choose Other Color...

[g,f R:195 G:195 B:145
—— M R:255 G:0 B:0

M R:255 G:128 B:0 |
R:0 G:255 B:0

M R:0 G:0 B:255

M R:128 G:0 B:128

R:230 G:230 B:179
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Uvelicajte prikaz da biste videli juznu stranu zgrade referentnog prikaza. Selektujte zid pored
ulaza levim klikom na njega i otvorite podesavanja za taj zid.

Na kartici Model u otvorenom prozoru za unos podataka promenite opciju Outside surface na
Stone — Sandstone | i kliknite na OK. Kliknite na ikonicu Rebuild Reference u Trace & Refe-
rence paleti da biste azurirali prikaz izgleda.

Trace & Reference

(5| | 2205 South Ele... » |
B @&

Rebuild Reference

Reference:

B | 2|
Active: >
Ll =¥
& | &[0

Azurirani izgled zgrade reflektuje promene koje ste izvrSili na aktivnom prikazu osnove. Otvo-
rite 3D prikaz. Kao $to mozete da vidite, zid sada pravilno prikazuje povrsinski materijal.

Vratite se na osnovu da istrazite jo§ jednu korisnu funkciju alatke Trace. Ako Zelite da vidite
razmestaj drugih spratova, dok radite na odredenoj osnovi etaze, kliknite desnim tasterom misa
na 1.2 floor i prikazite ga kao Trace referencu. Promenite mu boju na crvenu. Kliknite na dugme
Show/Hide Splitter da biste prikazali virtuelne razdelne linije na svakoj strani grafickog radnog
ekrana.

@ Trace & Reference

(E Ea1. 2 floor »
SFAEEE
Reference:

| | 4
Active:

® [ @ [0 &

Show/Hide Splitter (Display v.{ﬁly)

Povucite bilo koju od ovih razdelnih linija - napravite pocetni klik levim tasterom misa na iko-
nicu na sredini ivice radnog ekrana i povlacite je ka sredini ekrana da biste sakrili sadrzaj aktiv-
nog prikaza, a sadrzaj referentnog prikaza ucinili vidljivim.
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@ ArchiCAD File Edit View Design Document Options Teamwork Window Test Help S BN H ) 3 Do B = (O PaukoEnko Q :
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[Ba-1. foundation
» [@Soctions
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10205 South Elovatiol
10206 East Elovation
07 North Elevatior
(] 208 Wost Elovation
Interior Elevations
[Worksheets
» [@oetails
» 30 Documents
v@0
@ Generic Perspecti
 Generic Axonome
» 3100 Untitiod Path
v [@Schedules
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[ 0oor Scheduie
[ Uohtings tist
[ Obiect inventor
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[ Window Sched
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Zatvorite paletu Trace and Reference i iskljucite ovu opciju klikom na njenu ikonicu u Stan-
dard liniji sa alatkama.

Jedna od glavnih prednosti BIM koncepta je $to se negraficke informacije, kao §to su koli¢ine,
popis elemenata, Seme i rasporedi, mogu automatski ekstrahovati iz 3D modela. Pogledajte da
li su obuhvaceni svi aspekti BIM modela: dvostruko kliknite na Wall List u odeljku Element
Schedules u Navigatoru.

ESE- SIS
v {fis NHS OFFICE COMPLE:
» [&] Stories
» [@]Sections
» [€]Elevations
Interior Elevations
[Z]Worksheets
» [J] Details
» [$33D Documents
» [3]3D
v [E]Schedules
v [ Element
Door Schedule
Lightings list
Object Inventor
Roof Construct
Wall List
Window Sched|
Zones Scheduls
» (5] Component
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Bice prikazana interaktivna lista koja ukljucuje sve zidove koji su do sada postavljeni u projektu.
Mozete brzo da pronadete zid na prvom spratu koji ste upravo modifikovali. Neki parametri
(kao §to su visina ili viSeslojna struktura zida) mogu da se izmene i pomoéu ovog prikaza. Ove
promene ¢e biti reflektovane u svim prikazima (u osnovama, u prikazima preseka/izgleda ili u

3D prikazu).

[ 1st Floor Plan

Syl B m
Merge Uniform Items
Show Headline Settings...
Apply Format Options to:

Header
Font:

Arial [ |

Ml400 mm
M:t 2,00 mm 91 |m
| Wrap text

B|/|u
Cell Border:

Solid Line »

Footer Settings...

Cancel/Redo =l
Format Change: Brimnrim

Wall List

FA Header Options »

Freeze Schedule Header

G Generic Perspective

o

000 0 o0 koo

i
Selected: 0 Editable: 0
Scheme Settings...

200 xR B S v R R R
L]
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Vratite se ponovo na pocetni prikaz osnove - dvostruko kliknite na 0.1 Floor Plan u Navigatoru.
Smanyjite uvelicanje da biste videli ceo crtez.

To $to radite sa BIM modelom znaci da ne treba da podesavate komplikovane setove lejera za
razliite spratove unutar projekta. Spratovi, preseci i izgledi su odvojeni prikazi modela virtuelne
zgrade. U ARCHICAD-u prozor Navigatora olak$ava da se prebacujete izmedu razli¢itih prikaza
i reprezentacija BIM modela.
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Dvostruko kliknite na razlicite spratove (2 Floor, 3 Floor i tako dalje u odeljku Stories) i na
druge prikaze razlicitih stavki ispod: Section, Elevation ili Details itd.
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| 1/ ==
/ g

Svi ovi prikazi su samo derivati BIM modela. MoZe se generisati bilo koji broj prikaza i svi su
oni medusobno povezani, pa, ako se nesto promeni u jednom prikazu, promene ¢e biti reflek-
tovane i u svim drugim prikazima u celom projektu. Ovo je ogromna prednost u odnosu na
dokumentaciju koja je zasnovana na tradicionalnom 2D crtezu, u kojem se koordinate crteza
unose rucno. To ne samo da je produktivnije, ve¢ i pouzdanije, posto se smanjuje rizik problema
koordinacije na minimum.

Tok izrade dokumentacije

Naravno, posao je daleko od zavrSenog, i pored toga sto ogromnu koli¢inu informacija moZzete
da unesete i saCuvate unutar BIM modela. Medutim, arhitektonska dokumentacija sadrzi vise
interpretacija istog prikaza zgrade. Na primer, za odredeni sprat zgrade treba generisati planove
konstrukcije, reflektovane osnove plafona, planove zavrsnih obrada podova, strukturalne pla-
nove, razmestaj namestaja i tako dalje.

Osim toga, saradnicima koji su ukljuceni u projektima, kao $to su gradevinski inzenjer, inzenjer
elektrotehnike, inzenjer masinstva, instalater i tako dalje, potrebni su razli¢iti dokumeni. ARCHI-
CAD podrzava tok izrade dokumentacije pomocu prikaza sa podesavanjima. Nazovimo prikaze
pogledi (views).

Do sada smo koristili samo jedan deo Navigatora koji se zove Project Map.

Kliknite na ikonicu sa desne strane Project Mapa. To je View Map deo Navigatora, mapa sa
pogledima.

[ & 03|
v fip NHView Map sompLEs

Kao $to mozete da vidite, ovaj deo lista planove, umesto spratove. Naravno plan moze da prikaze
bilo koji prikaz modela (spratove, preseke, izglede, detalje i tako dalje). Dvostruko kliknite na 1st
Floor Plan u RCP direktorijum u odeljku View Map.
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2> & BED
VmNHS OFFICE COMPLE2
v [E]Floor Plans
[ Roof Plan
[ 3rd Floor Plan
[™32nd Floor Plan
[ 1st Floor Plan
[ Foundation Plan
v JRCP
| k- 1stFloor Plan |
[X32nd Floer Plan
[ 3rd Floor Plan

Odmah ¢e biti prikazan reflektovani plan tavanice prizemlja - Reflected Ceiling Plan.
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Po ¢emu se ovaj pogled razlikuje od prikaza na kojem smo do sada radili? Jedna razlika je oci-
gledna: vide se plocice reflektovanih plafona i elementi rasvete. Oni su sigurno sadrzani u okviru
lejera koji je ukljucen kada smo se prebacili na prikaz u RCP direktorijumu. Lejeri su kao neka-
dasnji papiri pergamenta, koji su se redali jedan na drugi - ako jedan izvucete iz gomile, on ¢e biti
nevidljiv. Elemente koji imaju zajednicke karakteristike (na primer, spoljasnji zidovi, unutra$nji
zidovi, namestaj i tako dalje) treba postaviti na zajednicki lejer da bi njihova vidljivost mogla da
bude regulisana istovremeno.
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Druga znacajna razlika je vidljiva samo ako se zumiramo na unutra$njost zgrade. Vrata su prika-
zana samo kao otvori (kao $to je obi¢aj na reflektovanom crtezu plafona).

D oI o}

oEEND D_:D a
T TR
B [

D/KDDEIMD

5 [t
OPEN TO ABO |:| | |

Za prikaz pogleda — view postoji Sest razlicitih faktora.

+2.800

[-]

m Layer Combination — kombinacija lejera, odreduje koji su lejeri ukljuceni ili
iskljuceni za odredeni pogled. U ovom primeru su kombinacije lejera podesene i
imenovane unapred. Na ovom pogledu je upotrebljena kombinacija lejera koja se
zove Reflected Ceiling Plan.

m  Drugi faktor je razmera (Scale) crteza. Na primer, crtezi koji se predaju komisiji za
odobrenje imaju manju razmeru od gradevinske dokumentacije. U ARCHICAD-u
objekti kao §to su vrata, prozori i drugi napravljeni elementi su senzitivni na
skaliranje; odnosno, njihovi 2D prikazi zavise od aktuelne razmere crteza.

m  Tredi faktor je Structure Display. Ova funkcija omoguéava da prikazete
konstruktivne elemente na razli¢ite na¢ine, u zavisnosti od toga kako definisete
komponente elemenata. Izaberite jednu od sledecih opcija:

= Entire Model — prikaz ¢itavog modela
= Without Finishes — prikaz bez zavr$nih obrada
= Core Only — prikaz glavnih delova elemenata

= Core of Load-Bearing Elements Only — prikaz jezgara samo noseé¢ih elemenata
konstrukcije
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Cetvrti faktor je Pen Set. Mozete da definiiete razli¢ite debljine linija za razli¢ite
boje koje se koriste za predstavljanje elemenata u 2D prikazima.

Slede¢i faktor je takozvani Model View Options Combination. Ova podesavanja
kontrolisu ponasanje ARCHICAD elemenata pomocu prakticno jednostavnih
ukljuc¢ivanja i iskljucivanja razlicitih opcija vidljivosti. Te kombinacije su takode
unapred podesene i imenovane. Kombinaciju za reflektovane crteze plafona mozete
da prikazete kada selektujete opciju Document/Set Model View/Model View
Options iz glavnog menija.

0,00, . . Model View Options

¥ Model View Option Combinations

Custom Store as...
Construction Documentation

Detailing Rename...
Drafting _—
Presentation l&J
Reflected Ceiling Plan T
Site/Context

Export...
¥ Options for Construction Elements

Show Beam as: Door Options:

(®) Entire Beam (") Show On Plans

O Reference Axis with Markers

() Contour Line (#) Show Opening Only
[ with Contours
(") Hide on Floor Plan

Column options:

& Show Column
Symbol $ Window Options:
(_)Show on Plans
with Markers

(®) Show Opening Only

Curtain Wall Options: # with Contours
@ Full (O Hide on Floor Plan
() Schematic -

Skylight Options:

(®) Show on Plans
Mark-up options: ™ with Markers
[gShow Mark-Up items () show Opening Only
(") Hide on Floor Plan

» Override Fill Display
» Options for GDL Obiects (ArchiCAD Library 17)

Cancel
T m—

Poslednji faktor je Renovation Filter. Mozete da obezbedite vizuelne povratne
informacije o statusu svakog elementa u odredenom stadijumu projekta renoviranja.
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Svaki pogled je definisan svim ovim faktorima, aktuelnim uveli¢anjem i dimenzijama. Klik na
Settings... u panelu Properties ispod Navigatora omogucava pristup svim ovim podesavanjima.

U Quick Options odeljku, koji se nalazi odmah ispod ovih opcija, mozete da promenite ova
podesavanja za aktuelni prikaz projekta. Da biste aktivirali paletu Quick Options, kliknite na
komandu Window/Palettes/Quick Options iz glavnog menija.

Br | 0 @3 D
V%NHS OFFICE COMPLE>
v [S]Flcor Plans
[aRoof Plan
[233rd Floor Plan
[32nd Floor Plan
[P35 1st Floor Plan
[aFoundation Plan
v [_JRCP
[ 1st Floor Plan
[32nd Floor Plan
[23rd Floor Plan
v [@]Elevations
{5705 South Elevatior
{5706 East Elevation
{5107 North Elevatior
{5708 West Elevation
¥ [_)Sections
701 A_A Section
3702 B_B Section
3103 C_C Section
13704 D_D Section

0] [
w Properties

O 1st | Floor Plan

5 [Reflected Ceiling Plan |
wlts0
@|Reflected Ceiling Plan |

Settings...

5 | Reflected Ceiling Plan »
@ 1:50

B Entire Model

9 NHS_18

@ Reflected Ceiling Plan

A 01 Existing Plan

= NHS_metric

Kliknite na bilo koje dugme i vidite promene koje ¢e se desiti na crtezu kada se menjaju ova
podesavanja.
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Kreiranje virtuelnih listova - Layouts

Kada imate model i podesene 2D poglede, treba samo da ih publikujete i podelite sa klijentima
i saradnicima.

U ARCHICAD-u se koristi Layout Book - da bi bili organizovani listovi projektne dokumen-
tacije, tako $to se jednostavno postave snimljeni prikazi i pogledi na virtuelne listove papire u
knjigu listova.

Kliknite na dugme Layout Book u Navigatoru.

L - -

Tree by subgsayout Book)

Hijerarhijom lejauta se organizuju lejauti. Numerisanje direktorijuma i listova je automatsko,
zbog preglednosti dokumentacije.

Dvostruko kliknite na lejaut Floor Plans/0102.2 1st Floor Plan. Plan osnove je vidljiv u origi-
nalnoj boji. Da biste promenili izgled crteza, jednostavno ga selektujte i promenite Pen Set na
Black and White, koristeci polje Info.

Defined by Pen Set Pl v Defined by Pen Set
ant background Grayscale

1 | Black and White

Napomena: Crtezi imaju mnogo podesavanja, pa ¢e mozda biti potrebno da skrolu-
jete u polju Info da biste prikazali padajucu listu dostupnih pen setova. Pomerite

kursor preko polja Info i upotrebite tocki¢ misa da biste skrolovali kroz sadrzaj polja.

Na lejaut mozete da postavite bilo koji BIM sadrzaj, ukljucujuéi i projektovane prikaze modela,
3D prikaze, detalje ili, Cak, Seme i rasporede, kao i eksterni sadrzaj (PDF, DWG, slike) ili njihove
kombinacije.

Mozete da podesite Master Layoute, matrice virtuelnih papira sa uvek prisutnim sadrzajem
listova, kao Sto su veli¢ina, uredenje crteza, okviri, blokovi naslova, legende, beleske i automat-
ski tekstualni ispisi (na primer, informacije o projektu, podaci crteza, podaci listova). Uvelicajte
desnu stranu lejauta da biste videli elemente oznacene crvenom bojom koji su sadrzani na Master
Layoutu.
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Master Item

To edit it, open the Master Layout.
Text

Layer: ArchiCAD Layer

PROJECT TEAM

Deljenje projekta
Ako su lejauti spremni, mozete da ih publikujete u nekoliko formata fajla. Sada pogledajte najce-
$¢e koriséene formate PDF, DWG, IFC i BIMx.

Kliknite na kolonu Publisher Sets u Navigatoru.

B QR

. Publisher Sets
Publisher St.~ A

U listi su prikazani dostupni setovi za publikovanje. Mozete da kreirate koliko god Zelite setova
za projekat.

Dvostruko kliknite na 01 — PDF i 02 — DWG setove da biste prikazali dodate lejaute. Upotrebite
dugme One level up da biste vratili prikaz liste setova.

(L Eh‘@ ;)
01 - PDF NE

One L 11U
> m NHS OFfeciamae el

Komunikacija sa uesnicima u projektu moze da bude zasnovana i na 3D prikazima. Najce-
§¢i format BIM razmene podataka je IFC format. Otvorite 03 — IFC set za publikovanje. Ovde
mozete da vidite dva primera IFC komunikacije modela. Ceo model je koristan za aplikacije za
pregled IFC modela u kojima mozete da spojite vise IFC modela i da proverite kolizije. IFC pri-
kazi zasnovani na spratovima su korisni gradevinskim inzenjerima koji analiziraju zgradu sprat
po sprat u svojim aplikacijama.
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Jo$ jedan mocan nacin komunikacije sa modelom je BIMx. Ova aplikacija omogucava deljenje
modela i dokumentacije (takozvani Hyper model) na mobilnim uredajima i desktop masinama na
veoma jednostavan i vizuelni nacin.

Otvorite 04 — BIMx set za publikovanje. Mozete da vidite da su ukljuceni i prikazi 3D modela i
lejauti. Publikovani fajl ¢e sadrzati i lejaut 1 3D prikaze sa inteligentnim linkovima 1 uklju¢enim
informacijama o elementu, pa u BIMx aplikaciji za pregled klijent moze da istrazi ceo projekat.

Cestitamo!

Dosli ste do kraja prvog dela! Ovde ste upoznali osnovni koncept BIM procesa u ARCHICAD-u.
Predite na slede¢i deo da biste saznali viSe detalja o procesu projektovanja.
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